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Word 2007/10/13  

1 Introduction 
Objectives 

 Understand the new Word 2007 Interface 

 Navigate the Office button 

 Learn about the Quick Access menu 

 Navigate the Ribbon menu  interface 

 Understand the I-beam 

 Learn basic editing techniques 

 Using Help 
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Introduction  

Microsoft Word is one of several popular word processing programs.  Most of 
these programs use the same basic techniques to help you write letters, reports, 
labels and other documents.   

 

 

Opening Microsoft Office Word 2007/10/13 

Click on the Word icon either from Windows desktop or Start 
menu.  In the Start menu, Microsoft Office Word 2007 is in the 
folder Microsoft Office. 

 

 

 

Microsoft Word 2007 Screen 

You will notice the new ribbon menu system.  The new menu uses contextual 
tabs, which are functionality specific only to the object with focus, and many 
other features like Live Preview enables you to view the document without 
making any permanent changes. 

 
Figure 1 - Home Ribbon 
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The New Office Word 2013 Start Screen 

 

 

This is the new Word 2013 opening screen.  It OK if you want to pull up your 
most recent document, but if you want to start a new document is another extra 
click.  Previous versions of Word automatically start with a new blank document. 

If you are use to the way previous versions of Word worked, it is easy to 
configure Office to bypass that screen for all of the Office programs.  

Lets put it back the way it use to work: 

1. Click File>Options. 

2. In the General window (which should appear by default), look to 

the "Start up options" section. Uncheck the box marked Show 

the Start screen when this application starts. 

3.  Click OK. 
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The New Office Menu in 2007/10/13   

There are three major features in the new Word 2007 menu system: the 
Microsoft Office Button, the Quick Access Toolbar, and the Ribbon Tab. 

 These three features contain many of the functions that were in the menu 
of previous versions of Word. The functions of these three features will be 
more fully explored later. 

The Ribbon Interface 

The ribbon menu is the standard  interface on all Microsoft products starting with 
Office 2007.   You simply click on the tab to navigate to a different ribbon.  When 
you launch Office work the Home ribbon is the first ribbon.  Within a ribbon, 
there are different sections. 

 

 

 
Office Word 2007  

 

 
New Office Word 2013 
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Note: In 2010, Microsoft has abandoned the Office Button and  return the 
original File menu concept back with the new File tab. 

 

1  

Office Word 2010 Ribbon 

Ribbon (Tab)  Section/Group 

 

Home Clipboard, Fonts, Paragraph, Styles and Editing.  

Insert Tables, Illustrations, Links, Header & Footer, Text, and Symbols 

Page Layout Themes, Page Setup, Page Background, Paragraph, Arrange 

References Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and 

Table of Authorities 

Mailings Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish 

Review Proofing, Comments, Tracking, Changes, Compare, Protect 

View Document Views, Show/Hide, Zoom, Window, Macros  

 

On Demand Ribbon 

Other tabs are On Demand tabs.  These menus are context sensitive to the task 
you are work on, like tables, drawings, diagrams, and charts. 
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For example, if you click on an inserted graphics, the menu associated with 
working with graphic will appear. 

 

Table Tools Design/Layout Context sensitive tab that appear when working 

with Tables 

Picture Tools Tab/Format Appears when working with graphics.  

Word Art Tools/Format Appears when working with WordArt. 

Text Box Tools/Format Appears when working with Text Box. 
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Exercise - On-demand Tabs 

The tabs are sensitive to the context in which you are working. To illustrate this, 
suppose you had inserted an image into your document.  

 

4. Open a blank document. 

5. Click the Insert tab. 

6. Click on Shapes 

7. Select any shape 

On selecting the image, the Picture Tools tab appears where previously it was 
hidden.  

8. Clicking away from the picture in a white area. 

9. Notice that the menu is hidden; click on the picture again. 

 

 

 

 

 

The Office Button or File tab (Word 2010) 

   
2007 2010 

In the upper-left corner is the Office Button.  However In Word 2010 this has 
been replaced by the familiar File tab.  When you click the button, a menu 
appears. You can use the menu to create a new file, open an existing file, save a 
file, and perform many other tasks relating to file management. 

 

On Demand Tool 
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Office 2010 

 

  
2007 Office Menu Options     2010 File Button Option 

 

The Office Button/ File tab tasks including: 
 

New Create new blank document 

Open Open an existing saved document 

Save Saves the current working document 

Save As Saves the current document with a different name, type or 

file location. 

Print Print all pages in the document or certain page.  You can 

print multiple copies and specify which printer to print to. 

Print Preview Display the document on screen as it will appear when 

printed 
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Publish Send your document to a server, web space or blog. Paste

 Pastes the contents of the Clipboard where your cursor is 

located (same as Edit, Paste) 

Close Close the current active document. 

Word Options Lets you customize Word. Note: Formerly known as 

Tools>Options in Word 95-2003. 

 

 

The Quick Access Toolbar 

 Next to the Microsoft Office Button is the Quick 
Access toolbar. The Quick Access toolbar provides you with access to 
commands you frequently use. By default Save, Undo, and Redo appears on the 
Quick Access toolbar. You can use Save to save your file, Undo to rollback an 
action you have taken, and Redo to reapply an action you have rolled back. 

 

 

Save - Saves the current document to it’s original 
location.  If the document os new, it will automatically 
prompt you to SAVA AS. 

 

 

Undo - Reverses editing actions.  In Word 2007 you 
have multiply levels of undo. 

 

 

Redo  - Repeats an editing command after using Undo 

 

 

Customize Quick Access Toolbar – You can customize 
your Quick Access Toolbar by checking or uncheck 
each selection. 
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The Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to 
complete a task. Commands are organized in logical groups, which are collected 
together under tabs. Each tab relates to a type of activity, such as writing or 
laying out a page. To reduce clutter, some tabs are shown only when needed. For 
example, the Picture Tools tab is shown only when a picture is selected. 

 

 
Figure 2 - Ribbon Menu 

 

The Ribbon Tabs 

The Ribbon tab is allows you to navigate through the ribbons. It has seven tabs: 
Home, Insert, Page Layout, References, Mailings, Review, and View.  Each 
Ribbon contains many new and existing features of Word which is divided into 
groups.  

 

Ribbon Groups/Sections 

The groups or sections are logical collections of features designed to perform 
functions that you will utilize in developing or editing your Word document. 
Commonly used features are displayed on the Ribbon, to view additional features 
within each group, click on the arrow at the bottom right of each group. 

 

Clipboard Section 

The Clipboard section is the same on all Office applications.  In 
this section, you will find the standard Cut, Copy and Paste.  
The concept of the clipboard allows you to copy and move text 
within your document or to another document.  This is not 
inclusive to just Office products.   You can copy and paste an 
image from the internet or from Photoshop.  But unlike 

Windows standard clipboard, Office allows multiple copies. 
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Paragraph Section 

 Contain tool for quick character formatting, such as 
bullet, list, multilevel list, indents, and justification (left, center and right).  You 
can also adjust line spacing, font highlights and color. 

 

Style Section 

 Contain tool for style formatting.  We will learn more about Style in Lesson 5. 

 

 

Editing Section 

 

 

 

Customize the Quick Access Tool Bar 

 

You can add or delete button to the  

Quick Access Toolbar.   Click on the arrow at 
the end of the toolbar to launch a list of 
buttons.  Check or uncheck the option you wish 
to add or delete.   Choose More Commands, if 
you want to add a tool that is not on the list. 
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Minimize the Toolbar 

Find and replace text in a document.  You can find the Select All function here. 
Additional you can select all the text with the same formatting. 

There is no way to delete or replace the Ribbon with the toolbars and menus 
from the earlier versions of Microsoft Office. However, you can minimize the 
Ribbon to make more space available on your screen. 

 

 

1. Click the arrow at the end of the tool bar. 
2. Click Customize Quick Access Toolbar.  
3. In the list, click Minimize the Ribbon.  
4. To use the Ribbon while it is minimized, click the tab you want to use, and 

then click the option or command you want to use. 

For example, with the Ribbon minimized, you can select text in your Microsoft 
Office Word document, click the Home tab, and then in the Font group, click the 
size of the text you want. After you click the text size you want, the Ribbon goes 
back to being minimized. 

 

Customize in Word Options 

 

You can also do more extensive 
customization in Word 
Options by going to the Office 
button. 
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Section/Group Dialog Launcher  

 

Some section group contain symbol in the right side of the box. 

 

Click on the dialog launcher button.  It will launch a dialog box 
relating to the context of the section.    For example, when you click on 

the Font dialog launcher, the Font dialog box will appear: 
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Font Section 

 

 

 

 

The Formatting tools in the Font section provides shortcuts to applying 
formatting commands, changing the appearance of selected text in a document.  
This is known as character based formatting.   

 

Character formatting is the lowest level of formatting and should be used 
sparingly.   In later Lessons, we wish learn more about formatting using Style and 
Themes. 

 

Font Section Tools 

 

Font List See the following pages for font styles.  

Font Size specify the size of the font to be used 

Bullets Create a bulleted list 

Increase Size Increase font point size. 

Decrease Size Decrease font point size. 

Increase Size Increase font point size. 

Clear Formatting Clear all formatting. 

 

Border Options Add borders to tables 

Highlighting Highlight selected text with color 

Font Color  Change text color 
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Basic Editing Techniques 
 

The Cursor or Insertion Pointer 

Notice that you have a blinking cursor or Insertion Pointer on your screen.  It’s 
the flashing black vertical line.  The location of the cursor is where your text will 
be placed when you type. 

 

The I-Beam 
 

You also have an Insertion Beam (also called an I-Beam).  It looks like a 
large, thin capital I.  If you don’t see this I-Beam, move your mouse 
around on the page until you do.  This is actually the mouse pointer.  
When you move the mouse pointer off the document area, it changes 

back to our familiar arrow. 
 

Beginning where you see the blinking cursor, type the word   Word  

 

 Deleting Characters 

There are several ways to delete or remove text that you have written 

 

Use the Backspace key        to delete characters to the left of the cursor 

Use the Delete key    to delete characters to the right of the cursor 

 

Move the I-Beam next to the letter you want to delete and click one time.  This 
will move the cursor to that location.  For example, move the I-Beam between the 
“r” and the “d” as in the following example, and click one time.  Your blinking 
cursor will now be located there. 
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Practice deleting another letter. 

 

Tip: Use the UNDO button to undo  and restore the letters you 
deleted! 

 

The magical, wonderful UNDO button:    

 

Deleting Words 

A basic technique in most Windows programs is known as “Select and then Do.”  
This means that you need to tell the program what you want to work with by 
selecting or highlighting those words or sections of your document. 

 

To delete an entire word, you can use the Backspace key or the Delete key for 
each letter in the word (as you just did), or you can select the word first and then 
delete it all at once. 

 

Type the word Fun.   To select or highlight a word, you can do a couple of things.   

 

Position the cursor just before the letter F.  Use the Click and Drag technique, 
holding down the mouse button and moving the mouse to the right until you get 
to the end of the word.  Release the mouse button.  Notice that the word is now 

Use the Backspace key  

to remove this character 

 

Wor d  

 

Use the Delete key 
to remove this 
character 
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Highlighted in black.  This means you have selected the word and can now do 
lots of things with it.   

 

Let’s delete it! 

 

 

Keyboard Technique 

With the word highlighted, simply press the Delete key.  This will remove the 
entire word. Press UNDO to bring it back. 

 

You can also select or highlight a word by using the double-click technique.  

Move the I-Beam into the middle of the word Fun.  Now double-click to highlight 
the word.  This may take some practice!  Press the Delete key. 

 

 Press UNDO to restore the word. 

 

The Clipboard 

Use the clipboard concept to cut copy or move text to a 
new location within your document or to another 
document. 

 

 

Using a Tool Button 

You can also use your Toolbar buttons on the ribbon is a quick method for using 
character formatting.   Pay close attention to the tool in the Font Section on 
Home ribbon. 

 

Highlight the word Fun  (double-click) 

Click on the Cut button        

 

-or- 
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Click on the Delete Key     

 

-or- 

 

Position the cursor after the n, press the Backspace 3 times. 
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Tip - Cut & Paste Shortcuts 

You can use the standard Windows control key shortcut to cut, copy and paste 
selected text in your document. 

 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 
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Insert Characters 

1. Type the word Word. 

 

To insert a new character into text that you have already typed, 
position the I-Beam at the location where you want to insert a new 
character and click one time.   

 

2. As you did before, position the I-Beam between the letters “r” 

and “d” and click one time. 

3. Type the letter “l”.    You will now have changed the word Word 

to World! 

4. Press the UNDO button and try this again. 

 

Inserting in the Middle of Text  

 

You can insert text anywhere in the middle of text.   By default the Insert mode is 
ON, which mean that text will automatically move to the right and wrap around 
to the next line when you type. 

 

Note: On previous versions of Word, you can turn the Insert mode OFF, this is 
known as OVR (Overtype).   The OVR indicator is gone on the new Word 2007. 

 

If you wish to overtype a sentence, simply select it and type new text over it. 

 

Text after selection: 

I what to xxxxxxxxxxxx xxxxx  line with another line.   Just select it and type 
“overtype this”. 
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Result: 

I what overtype this line with another line.   Just select it and type “overtype 
this”. 
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Create a Document 

Exercise - Create a Simple Letter 

To begin working with a new document or a blank piece of paper, click on the 
New button on Office Button.   This is the first button at the left side of the 
toolbar:   

Type the following letter.   Begin typing where you see the blinking 
cursor. 

 

 

 

 

 

 

 

 

 

 

 

T
I
P
:
   

 

 

 

 

If you want more space at the top of your letter, press the ENTER key 
a couple of times.  This key can be used to insert blank lines at the 
beginning of the document. 

 

As you begin, keep in mind the following points: 

 

 

September 16, 2008 

 

 

Dear Ms. Smith: 

 

Thank you for your interest in the E. M. Hart Community 

Center services.  We hope you enjoy the current newsletter 

that we have enclosed.  Please feel free to call us if you have 

any questions regards the current offering. 

 

Sincerely, 

 

 

Susie Jones  

 



Word 2007 1.25 3/28/2013 

 

Don’t worry too much about spelling or speed.  Remember, this is not a typing 
test!!  Word has a special feature to help you check all of your spelling when you 
have finished entering your text. 

 

After typing the date, press Enter 2 or 3 times to enter blank spaces.  Do this 
again after typing Dear Ms. Smith: 

 

As you work, do not press the Enter key at the end of a line in the large 
paragraph.  (Only press Enter when you want to start a new blank line.  Word 
will wrap your sentences automatically as you type. 

 

Do press Enter 3 or 4 times after typing Sincerely, 
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Spell Check  

 

One of the greatest features in any word processing program is Spelling & 
Grammar check.  The program will check each word in your document and alert 
you to any words that may possibly be misspelled.  Unfortunately the program’s 
dictionary cannot include all the proper names we frequently use and the 
program may tell you that Susie is not a correctly spelled word! 

 

Remember that Word is only looking for misspelled words.  If you type “they” 
instead of “the”, the program will not catch the error because “they” is correctly 
spelled even though it may not be the word you intended to use.  You must 
always proof your own work! 

 

From anywhere in the document, click Review tab, then on the Spelling 
& Grammar button:    

 

 

 

When Word finds a misspelled word, a smaller window called a Dialog Box 
will open.  You will be asked if you want to Ignore the misspelled word and make 
no change to the word or Change the word to one of the suggested words.  Click 
on the appropriate button. 
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When the spell check is complete, you will see another box telling you the 
program has finished checking your document.  Click OK. 

 

 

  Congratulations if you had no spelling errors!    

 

 

Spelling Exercise 

 

Open Sample Document.doc 

 

Use spelling checker to coreect this paragraph for spellin mitake and grammer 
errors... You can use Auto Correct to make the changes   Just sellect the 
AutoCorrect button in the dialog box. 
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Saving Your Work 

 

Always Save Your Work!!!   When you have a long letter or 
document, stop in the middle and save what you have typed.  When 
you are finished, save it again!   

 

The first time you save a document, Word will ask you to give it a name and 
location. 

 

1. Click on the Office Button. 

2. Click on Save As 

3. A new dialog box will open 
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4. Tell Word to save your document in the folder called 

Documents. 

5. Type a name for your document.  Note:  The name can be 
anything you want and almost as long as you want include 
spaces. 

6. Call this document Community Center Letter 

7. Click on the SAVE button. 

 

Once you have saved your document with a name and location, you can click on 
the Save button at any time to quickly save your document as you work.  This is 
important to do frequently if you work in an area where power outages easily 
occur.   If you wish keep the old document and save the new edits under a new 
name, then use the SAVE AS button. 

 

 

Click now on the Save button on the Quick Access Menu   

 

Change File Type 

Mouse over the Save As icon in the Office Menu.  A selection of popular file types 
will appear in the right pane.   If you need to share this file with others, you 
cannot be certain that they have the latest copy of Word.   Save it to a lower 
version of Word.  Select “Word 97-2003 Document” from the list in the right 
pane. 
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2007 

 

 

2010 
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Save As Other Formats 

You as change the file type in the Save As dialog box.  Click on the  in the Save 
as type: field. 

 

 

 

Select the file type from the list box: 

Note: PDF format is not a standard Office Word feature.  You need to install a PDF 
writers either from Primo (Free) or Adobe. 

 

 

 

PDF 

Portable Document Format. It's a distribution format common on the internet for 
sharing documents.  It was developed by Adobe Corporation to allow electronic 
information to be transferred between various types of computers. The software 
which allows this transfer is called Acrobat. In order to view and print a PDF file 
you will first need to download and install a copy of the Adobe Acrobat Reader.    
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Close and Reopen a Document 

Close your document 

Once you have saved your document, you can safely close it.   If you try to close a 
document before saving any changes that you have made, Word will ask you if 
you want to save those changes.  Read each message box carefully so that you 
don’t lose your changes! 

 

Click on the Lower X in the upper right corner.  The Top X will close the Word 
program.  The Bottom X will close the current document. 

-or- 

Click on the Office Button, then on the word Close.    Remember, the word Exit 
will close the Word program.  The word Close will close the current document. 

 

Open a Saved Document 

To open a document that you have already created, click on the Open button 

 

-or- 

 

Click on the Office Button, then click Open. 

 

Note: If you Open button does not appear click the arrow 
on the Quick Access toolbar to add it. 

C 

 

You must now tell Word where to find your document.  Navigate the folder list to 
find your document. 
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Figure 3 - Open Dialog Box 

 

 

Click Open to open your file.   (Notice that we are using the terms file and 
document interchangeably) 

 

Once your document is opened, you can add to it or edit it as needed.  Remember 
to save your document if you make any other changes! 
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Printing 

1. To print your document, the Office Button, then click Print 

2. Click OK to print the default setting (1 copy). 

 

The Print dialog box will let you select the number of copies to print, select the 
printer you want to use if you have more than one available, and select a range of 
pages to print or the entire document. 

 

 

 
Figure 4 - Print Dialog Box 

 

 

Note:  You can also print by clicking on the Print button: 
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Important note:  Using the print button will automatically print one 
copy of your entire document on your default printer.  Use the File menu 
option if you want to print more than one copy or use another printer. 

 

Properties – You can change the print quality or paper type.  This 
setting will be different depend on your printer. 

 

 

Help 

To display the Word 2007 Help Dialog box, just click on the Help icon in 
the upper left corner of your windows. 

 

 
Figure 5 - Help Windows 
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Getting Started Tab 

The Get Started tab contains video demos, interactive guides, and online training 
courses that show you how the Office 2007 programs work and where the Office 
2003 commands and buttons appear in the Office 2007 programs. 

 

 

 

 

 

The Interactive Guide 

This is for users who are already family with Word 2003.  The guide will show 
the same commands in both 2003 and 2007. 

 

When you click on the interactive Guide it will take you to the Microsoft Office 
web site.   Once you're there, click on the button the start the guide. 

 

Rest the mouse pointer over a Word 2003 menu or button to learn its new 
location in Word 2007. To see an animation of the location of the command or 
button in Word 2007, just click it. 



Word 2007 1.37 3/28/2013 

 

Save you work 

 

1. Save and Close your document after it has printed. 

2. Close, but do not save, any other open documents. 

3. Close the Microsoft Word window. 

 

Safely shut down your computer 

1. Be sure you have closed the Microsoft Word 2007 

2. Click on the Start button in the lower left corner of your screen 

3. Click on the ►, the then click Shut Down 

4. Press the Yes button 

 

 
Figure 6 - Vista Shutdown 

 

Your computer will turn itself off automatically! 

 

 

 


